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StarVIEW Help Index 
 
How To... 
 Set up the system 
 Set the accelerometer calibration 
 Calibrate the system 
 Enter test definitions 
 Run tests 
 Display and print graphs 
 Store and retrieve data 
 Tune the controller parameters 
 Connect and use the Remote Input option 
 Convert tests created using the version 1.x software 
 Create customized reports 
 
 Call Vibration Research Corporation at (616) 669-3028 with additional questions. 
 
Menu Commands 
 File menu 
 Configuration menu 
 Test menu 
 Graph menu 
 View menu 
 Window menu 
 Help menu 
 
 
Control Center Typical Screen Stop Codes 
Repetitive Shock Repetitive Shock Repetitive Shock 
Chamber   

 
Quick Setup Instructions 
 

1. If you are installing the hardware into your own computer, read the "Computer 
Requirements" section. 

2. Install the hardware as described in the "How to install the hardware" section. 
3. Install the software as described in the "How to install the software" section. 
4. Run StarVIEW by double-clicking the StarVIEW icon on the desktop. 
5. Set the accelerometer mV/g levels as described in the "How to Set the Accelerometer 

Calibration" section. 
6. Read the rest of the manual (or online help) for details on how to change parameters, 

change tests, and change test types.  Note: Pressing the <F1> key at any time while 
running StarVIEW will open up a window with help information describing the active 
window or dialog box. 

Computer requirements 
 

 A Pentium computer (We recommend 350MHz or faster).  The program will run on 486 
machines, but the graph display speed will be unacceptable. 

 VGA video card & monitor.  We recommend using a screen resolution of 1024 x 768 or 
higher. 

 Mouse and keyboard 
 3.5" floppy disk drive or CD-ROM drive or network connection. 
 Hard disk drive with 50 MB of free space. 
 Microsoft Windows 95, 98, NT 4.0 or 2000 operating system. 
 Parallel port for the software protection key and printer. 
 16 MB RAM minimum (64MB recommended). 



 Any Windows-compatible printer (optional). 
 Vibration Research Corp. supplies the analog I/O unit, and the software key. 

 
How to install the hardware 
 
About the Key 
 
The software key is shipped taped to the inside cover of the StarVIEW Users Manual.  It is a 
small white 25-pin connector with your company name on one side and the test types to which it 
gives you access on the other.  This key is essential to the proper functioning of StarVIEW.  It is 
the key that unlocks the software, allowing you to run the test types that you have purchased.  
The key must be plugged into the parallel port (printer port) on the rear of the controller computer 
for the controller to run a test. 

 
You can install and run the StarVIEW program on a computer without the key attached (for 
example, your office computer) to read in data files created by the controller computer, and print 
graphs and reports of that data.  All functions will work without the key attached, with the 
exception of actually running a test. 
 
The key can be connected in-line with your printer cable, allowing you to use both the key and the 
printer at the same time.  You can attach any peripheral (usually a printer) that you desire by 
connecting it to the open, female end of the key. 

 



Connecting the StarVIEW I/O Hardware: 
 
1. Set up the computer in the conventional configuration, with power 

cables, mouse, keyboard, and monitor. 
2. Plug the Security Key into the parallel port of the computer. The 

Security Key is shipped in the front cover of the manual.  If you 
have a printer installed, install the key between the computer's 
parallel port and the printer cable. 

3. Connect the serial cable between Com1 of the computer and Process 
Loop Controller.. 

4. Insert VRC supplied parallel port card into the computer. 
5. Connect the IO Tech DAQBook to VRC supplied.supplied parallel port.  

Do not connect key and IO Tech to same port! 
6. Connect power to the IO Tech DAQBook.. 
7. Connect accelerometers to Input Channels 1,2,3,4 of the IOTech IO 

unit.  This unit does not supply current for accelerometers.  If 
required a user supplied device must be connected between the IOtech 
IO and the accelerometers. 

 
 
 
How to install the software 
 
This software package runs on Microsoft Windows 95, 98, NT 4.0, and 2000. 
 
Installation in Windows 95 and Windows 98 
 
If you purchased this system with a computer, the software will already be installed.  Otherwise, 
install the software using the following steps if the install program does not start automatically: 
 

1. A CD-ROM containing the StarVIEW software is supplied with your system.  Run the 
program "R:\install\setup.exe" on the CD-ROM (where R: is the drive letter for your CD-
ROM drive). 

2. The install program (setup.exe) will prompt for the location to install the program.  Click 
the "Next >" button in each dialog box to accept the default values.  When installation is 
complete, click the "Finish" button. 

3. If you are using a added parallel port with the DAQBook use the "Add New Hardware" 
tool in "Control Panel" to configure added port. 

4. Watlow F4 must be setup with "Watlow Setup" found under "Chamber View" in the Start 
Menu.  Setup Walow as shown below.  Do not setup Watlow if you are using JC Systems 
or Sun Controllers! 

5. IOTech hardware must be setup with "IOTech Setup found under "Chamber View" in the 
Start Menu.  If no devices shown under Computer Icon use Add Device to add new 
device.  Select "Daqbook/216 from drop list.  Setup options as shown below.  If the 
options don't look like the example below verifiy that you selected DaqBook/216 not 
DaqBoard/216. 

 
To run the software, double click the StarVIEW icon on the desktop.   
 
 
Addition Information: 
WATLOW Setup 



 
 
DAQBook Setup 

 
 



JC Systems Setup 
 
Computer Interface: TYPE_422 
Address# 1 (Temperature Controller) 
Address# 2 (Vibration/Humidity Controller) 
Baud: 9600 8Bit None 
 
How to set the accelerometer calibration 
 
The calibrated mV/g settings for your accelerometers are entered by selecting the 
Configuration..Accelerometer Sensitivity menu command.  For each channel, enter the calibration 
factor (in mV/g) for the accelerometer in use on that channel.  This calibration factor is normally 
stamped on the accel or supplied on an accel calibration sheet.  You may also (optionally) enter a 
serial number and a calibration date for each accelerometer to aid in tracing the current 
calibration settings. 
 
When the appropriate values are entered, click the "OK" button.  The new accelerometer 
sensitivity factors will take effect immediately. 
 



How to Calibrate the system 
 
Note: If you just received your system from Vibration Research this calibration does not 
need to be done until the due date on the Calibration Certificate in the back cover of the 
manual. 
 
 
This calibration procedure should be performed annually. 
 

1. Connect a power cord to the VibrationVIEW I/O unit. 
2. Connect 2 coaxial cables together with a T-connectors. 
3. Connect one end of the cable to a shorting plug. 
4. Connect the other end of the cable to the Digital Volt Meter (DVM). 
5. Connect the T-Connector to Input#1 on the IOTech Box. 
6. Turn the unit on, and allow 1 hour for the temperature to stabilize before performing 

calibration. 
7. Run StarVIEW. 
8. Load test profile "calibration.vcp" (or set up new test with all channels active and only 

channel 1 selected for control. 
9. Select the Configuration..Parameters menu command. 
10. Click the Calibration tab. 
11. Connect one end of the cable to a shorting plug. 
12. Connect the T-Connector to Input#1 on the IOTech Box. 
13. Verify DVM reads 0.000VDC. 
14. Click the "AZ" (auto-zero) button to set the input offset value for channel 1. 
15. Repeat steps 12-14 for each additional channel 
16. Click the "Apply" button.  If a password is required use "Control". (Case Sensitive). 
17. Remove Shorting plug from opposite end of coaxial cable, and plug Function Generator 

in its place. 
18. Set the Function Generator to output Sine waveform at 1000Hz at 1.000Vrms.  Verify 

Frequency and Amplitude with DVM. (+/- 20Hz, +/-0.001 Vrms) 
19. Set DVM to display DC voltage.  Adjust Function Generator DC offset until DVM reads 

0mVDC  (+/-5mV). 
20. Set DVM to display AC voltage.  Verify amplitude 1.000vRMS (+/-0.5 mV). 
21. Connect the T-Connector to Input#1 on the IOTech Box. 
22. Press "AG" (auto-gain) button to set input gain value for channel 1. 
23. repeat steps 21-22 for each additional channel 
24. Click the "Apply" button.  If a password is required use "Control". (Case Sensitive). 

 



Optional Output Calibration (Not Required if Output Channel is not used) 
 

25. Connect one end of the cable to a shorting plug. 
26. Connect the T-Connector to Input#1 on the IOTech Box. 
27. Set Output Channels channel 1 Gain Multiplier=1.00 
28. Connect the DVM to the StarVIEW Output#1 (pins 7(ref) & 9(+VDC) on the 37Pin 

Connector on the IOTech Box. 
29. Enter Voltage read on the DVM (DC mV) into the Output Channels Offset Box for 

channel 1. 
30. Remove Shorting plug from opposite end of coaxial cable, and plug Function Generator 

in its place. 
31. Set the Function Generator to output Sine waveform at 1000Hz at 1.000Vrms.  Verify 

Frequency and Amplitude with DVM. (+/- 20Hz, +/-0.001 Vrms) 
32. Set DVM to display DC voltage.  Adjust Function Generator DC offset until DVM reads 

0mVDC  (+/-5mV). 
33. Set DVM to display AC voltage.  Verify amplitude 1.000vRMS (+/-0.5 mV). 
34. Connect the T-Connector to Input#1 on the IOTech Box. 
35. Connect the DVM to the StarVIEW Output#1 (pins 7(ref) & 9(+VDC) on the 37Pin 

Connector on the IOTech Box. 
36. Enter Voltage read on the DVM (DC mV) into the Output Channels Gain Multiplier Box 

for channel 1. 
37. Click the "Apply" button.  If a password is required use "Control". (Case Sensitive). 

Calibration is now complete. 
 



How to enter tests 
1) Start a New Profile 
 

 

Click "Easy New Test" on the Toolbar 

 
2) Enter a Sequence 
 

 

Define a starting temperature and vibration 
 
 

 

Define a target temperature and vibration. Use Normal Step Action
to Ramp to Temperature 
 

 

Define a Duration Time for the First Step 
 
 

 
Enter a temperature soak step on the second line 
 
 

 
Ramp Vibration to 10 G's over 10 Seconds 
 
 

 
Enter a 5 minute vibration test 
 
 

 
Ramp Vibration back down 
 
 

 Ramp Temperature back down 
 
 

 
Sequence will now look like this: 

 
 

click the  button when complete 
 
3) Define the outputs: 



 
Your required outputs will very depending on the configuration of the chamber. 
This example shows a dedicated output to run vibration turned on for each step with vibration. 
 

click the  button when complete 
 



3) Define the parameters: 

 
Suggested values are adequate for most tests. 
 

click the  button when complete 
 
4) Define the Spectrum Channels 

 
Channel 1 shown defined for X Axis. 
Channel 2 shown defined for Y Axis. 
Channel 3 shown defined for Z Axis. 
Channel 4,5,6,7,8 shown disabled. 
 
Control Output uses average of X,Y, and Z Axis 
 

click the  button when complete 
 



5) Define Data Storage 

 
 

click the  button when complete 
 
6) Retain test as a new file 
 

 
Select Yes to retain this test for future use.  Enter a new test name when prompted. 
 
How to run tests 
 

 How to run the Repetitive Shock test 
 
How to run a Repetitive Shock test 
 
To run a Repetitive Shock test select the Test..Open Test menu command or click the "Open 
test" toolbar button.  A list of test names is displayed.  Select Files of type "StarVIEW Chamber 
Profiles (*.vcp)" and select the test you wish to run.  Click the "Open" button to load that test. 
 
To run the test, click the "Run" button in the Chamber Control Center. To stop the test, click the 
"Stop" button.  



How to display and print graphs 
 
The graphs for StarVIEW are where the majority of the test actions are observed.  To display a 
graph, select the File..New Graph menu commandor click the "New Graph toolbar" button.  A 
dialog box appropriate for the current test will appear.  See the appropriate section for specifics 
on the available graph types: 
 

 Repetitive Shock Settings dialog box 
 
Several keyboard and mouse shortcuts are available to manipulate the graph display: 
 

 Ctrl-G to edit the graph settings 
 Ctrl-A to autoscale the vertical (Y) axis 
 Ctrl-F to autoscale both the vertical and horizontal axes 
 Ctrl-D to toggle the cursor display 
 F8 to insert an annotation 
 F7 to remove an annotation (click on the annotation text with the left mouse and then press 

F7) 
 F4 to move an annotation (click on the annotation text with the left mouse, press F4, move 

the annotation to the new location, and click the left mouse button to select the new position) 
 

 Click and hold down the right mouse button, move the mouse to draw a rectangle, and 
release the mouse button to zoom in on an area of the graph. 

 Double-click the right mouse button to zoom out to show all of the data 
 
Using the Clipboard 
While a graph is displayed, it can be copied to the Windows Clipboard by clicking on the graph 
with the mouse, and then selecting the File..Copy Graph menu command, clicking the "Copy 
Graph" toolbar button, or by pressing Ctrl+C.  After copying the graph to the clipboard, switch to 
the application into which you want to paste the graph image, and use that application's 
Edit..Paste menu command.  You can then resize it to meet your needs.  The Edit..Paste 
command will only work in applications that are able to use metafile graphics (e.g. Microsoft 
Word). 
 
Windows also allows you to copy the active dialog box or the entire screen to the clipboard: 

 To copy just the active window or dialog box, hold down the "Alt" key and press the "Print 
Scrn" key (usually found above the numeric keypad). 

 To copy the entire screen to the clipboard, press the "Print Scrn" key by itself. 
Then go to the desired application, and use that application's Edit..Paste menu command to 
insert the copied image. 
 
Using the Printer 
To print a graph, select the graph by clicking on it with your mouse, and then by selecting the 
File..Print Active Graph menu command or clicking the "Print Graph" toolbar button.  A dialog box 
will appear prompting you for the printer to which to print the graph.  Select an appropriate printer, 
and click the "OK" button.  The graph will then be printed to the selected printer. 
 
You can also select the File..Printer Setup menu command or the File..Print Options menu 
command to modify your printer parameters. 
 
Laser printers that only print in black and white will produce the best graph output if you select 
BLACK AND WHITE mode rather than COLOR mode when creating a new graph.  To change a 
graph from color to black-and-white, edit the graph settings by selecting the Graph..Edit Graph 
Settings menu command or clicking the "Edit Graph" toolbar button, change the style from "Color" 
to "Black and White" and clicking the "OK" button. 
 



How to store and retrieve data 
 
How to store Data 
To store the data for the current test, select the File..Save Data menu command or click the 
"Save Current Data" toolbar button.  A dialog box will appear prompting you for a file name into 
which to store the data.  When the "Save" button is clicked all parameters for the current test will 
be saved to the hard drive. 
 
The default directory for saving data is set in the test specification.  Select the Test..Edit Test 
menu command, and then click the Data Storage tab to define the default data directory for the 
current test. 
 
The default file name has the form "Aug25-1617-0001" where "Aug25"indicates the date and 
"1617" indicates the time the test was started (i.e. August 25 at 4:17 pm). 0001 is an index value 
that is incremented every time a file is saved while the test is running.  Therefore, for a test begun 
at 4:17 pm on August 25, the default names for the data files will be "Aug25-1617-0001", "Aug25-
1617-0002", "Aug25-1617-0003", etc.  Automatic data storage will always use this sequence of 
file names.  When you manually store the data (using the File..Save Data menu command) you 
may change the file name to anything you desire before clicking on the "Save" button. 
 
How to View Stored Data 
To view stored data, select the File..Open Data menu command or click the "Open Stored Data" 
toolbar button.  A dialog box will appear prompting you for the name of the file you wish to view.  
Select the desired file, and click the "OK" button.  A graph with the stored data will be displayed.  
Select the Graph..Edit Graph Settings menu command (or press Ctrl-G) to change the traces 
and/or type of the graph. 
 
Hint: While a stored graph is displayed, you can use the left and right arrow keys to scan 
backwards and forwards in time through all of the data files stored in the same directory as the 
currently displayed file.  Using this feature you can quickly scan through many stored data sets. 
 
To create a formatted report of the data displayed in the current graph, select the File..Create 
Report menu command. 
 
How to tune the controller parameters 
 
 

 Access PID Settings from Configuration Menu. 
 
How to convert tests created using the version 1.x software 
 
Select the File..Read Old File Formats..Test Profiles menu command to bring up a File Open 
dialog box.  Select the test file from those listed in the dialog box.  Click the "Open" button and 
the test will be loaded. 
 
If a test of the same name with the new format is not present, the converted test will be 
automatically saved to the same directory with the same file name, but with the new file format's 
extension.  The old format test will not be changed by the version 2.x software, so it can still be 
used with the old software. 
 
To ensure that the converted test is saved, and to change the name and directory into which it is 
stored, select the Test..Edit Test menu command to open up the edit test dialog box, and click the 
"Save As..." button to select a directory and filename into which to save the test. 
 



How to create customized reports 
 
Reports are generated using mail merge type processing.  The program reads in a template file, 
substitutes data values and graphs in place of keywords, and writes the resulting data to an 
output file.  The template files can be either plain text or Rich Text Format files.  Plain text files 
can have data values but no graphs.  Rich Text Format files (using extension .rtf) can contain 
data values and graphs, as well as any text formatting and other graphics elements that can be 
inserted into an RTF file. 
 
The default templates are stored in subdirectories of the directory c:\Program 
Files\StarVIEW\Templates.  / 
 
File menu commands 
 
The file menu is used for loading, saving, copying, and printing data files and graphs.  It offers the 
following commands: 
 
New Graph Creates a new graph. 
Copy Graph Copy the selected graph to the windows clipboard. 
Save Meta File Saves the selected graph in emf format 
Save Bitmap File Saves the selected graph in bmp format. 
  
Open Data Read a stored data file from the disk. 
Previous Data Read the previous data file from the disk. 
Next Data Read the next data file from the disk. 
Save Data Save the active data set to the disk. 
Close Closes an opened graph. 
  
Read Old File Formats Read test profiles and data created with version 1.x software. 
  
Create Report Creates a saved report using a defined template 
Print Report Creates a printed report using a defined template 
Print Active Graph Prints the selected graph. 
Printer Setup Selects a printer and printer connection. 
Print Options Changes the graph scaling options used for printing. 
  
Explorer Starts Windows Explorer 
Exit Exits StarVIEW. 

 
 
New Graph command (File menu) 
 
Use this command to create a new graph in StarVIEW.  A dialog box will prompt you with the 
types of graphs available. 
 
For more information on the graph dialogs and graph types for the various tests, see: 
 

 Repetitive Shock Graph Settings dialog box 
Shortcuts 

Toolbar:  
Keys: Ctrl+N 
 



Copy Graph command (File menu) 
 
Use this command to copy the selected graph onto the clipboard.  Once on the clipboard, it may 
be pasted into another application, such as a word processor, using that program's Paste 
command. 
 
Copying data to the clipboard replaces the contents previously stored there. 
 
Shortcuts 

Toolbar:  
Keys: Ctrl+C 

 
Save Meta File (File Menu) 
 
Use this command to save the currently selected graph to a file using the Meta File (emf) format.  
Graphs saved in this form may then be imported into another application, such as a word 
processor, but StarVIEW cannot read these files, nor can the graph scales be changed. 
 
Select the File..Save Data menu command to save the raw data for later loading and viewing in 
StarVIEW, with full control over the scaling and format of the graphs. 
 
Select the File..Copy Graph menu command to copy the graph image to the windows clipboard 
such that it can be directly pasted into another application. 
 
Save Bitmap File (File menu) 
 
Use this command to save the currently selected graph to a file using the Bitmap File (bmp) 
format.  Graphs saved in this form may then be imported into another application, such as a word 
processor, but StarVIEW cannot read these files, nor can the graph scales be changed. 
 
Select the File..Save Data menu command to save the raw data for later loading and viewing in 
StarVIEW, with full control over the scaling and format of the graphs. 
 
Select the File..Copy Graph menu command to copy the graph image to the windows clipboard 
such that it can be directly pasted into another application. 
 
Open Data command (File menu) 
 
Use this command to read a data set previously saved in StarVIEW using the File..Save Data 
menu command.  An Open File dialog box will be displayed, allowing selection of the data set you 
wish to view.  Use the Window menu to switch among the multiple open documents.  See the 
Window 1, 2,.. menu command. 
 
Shortcuts 

Toolbar:  
Keys: Ctrl+O 
 



Previous Data command (File menu) 
 
Use this command to read and plot the data file stored in the same directory as the current file, 
but stored immediately prior to the current file.  This command is available only when a graph of a 
stored data file is the currently selected graph type. 
 
This command, along with the Next Data menu command, is useful for quickly scanning through 
a set of data files in a directory in chronological order. 
 
Shortcuts 

Keys: Left arrow 
 Down arrow 
 Keypad Minus (-) 

 
Hint:  To see multiple types of graphs of each data file, select the Window..New menu command 
and the Window..Tile menu command to create and arrange multiple graphs before using this 
command to scan through the files. 
 
Next Data command (File menu) 
 
Use this command to read and plot the data file stored in the same directory as the current file, 
but stored immediately after the current file.  This command is only available when a graph of a 
stored data file is the currently selected graph type. 
 
This command, along with the Previous Data menu command, is useful for quickly scanning 
through a set of data files in a directory in chronological order. 
 
Shortcuts 

Keys: Right arrow 
 Up arrow 
 Keypad Plus (+) 

 
Hint:  To see multiple types of graphs of each data file, select the Window..New menu command 
and the Window..Tile menu command to create and arrange multiple graphs before using this 
command to scan through the files. 
 



Save Data command (File menu) 
 
Use this command to store the data to a file that may then be loaded back into StarVIEW using 
the File..Open Data menu command for viewing and printing.  This command will bring up a Save 
As... dialog box with a default file name derived from the date and time the test began and an 
index that is incremented every time a data set is stored.  The file name may be changed if you 
so desire.  Click on the "Save" button to save the data to a file. 
 
Note: The live data stored in the file is that data that is displayed when the "Save" button is 
pressed in the Save As... dialog box.  If you want to save a particular set of data (for example, a 
transient occurrence in an FDR playback file), click the "Save" button as soon as you see the 
data you want to save appear in the graphs.  This data may then be loaded again for analysis.  In 
this way, the Save Data menu command may be used as a form of freeze-frame for the live data. 
 
Shortcuts 

Toolbar:  
Keys: Ctrl+S 
 

Close command (File menu) 
 
Use this command to close the active graph. 
 
Shortcuts: 

Mouse Click the X in the upper right corner of the graph window: 

  
 Or: Double-click the graph's system menu. 
 Or: Select Close from the graph's system menu.  The graph's system menu is 

accessed by clicking the icon in the upper left corner of the window, as shown 
below: 

  
 

Read Old File Formats command (File menu) 
 
Use this nested menu to read test profiles or data files created using version 1.x of the StarVIEW 
software.  Two options are given: 

 Test Profiles 
 Data 

 



Old Test Profiles command (File menu) 
 
Use this command to read test profiles created using version 1.x of StarVIEW.  An Open File 
dialog box will be displayed, allowing selection of the test to load. 
 
If the test has not previously been converted to the format used in version 2.x of StarVIEW, a new 
file will be created with the same base file name, but with the filename extension changed 
according to the following table: 
 
This command will not change the version 1.x format file, so that file may still be used with the 
older software.  Also, this command will not overwrite any files.  To force StarVIEW to overwrite a 
test file, load the file into StarVIEW, then use the Test..Edit Test menu command to edit the test 
and click the "Save As..." button in the Edit Test dialog box. 
 
Old Data command (File menu) 
 
Use this command to read data sets created using version 1.x of the StarVIEW software.  An 
Open File dialog box will be presented, allowing selection of the data set to read. 
 
Create Report Command (File Menu) 
 
This command will create a document with a variety of useful information and graphs.  The 
information saved depends on the template that you choose. 
 
To create a report select the File..Create Report menu command, choose a template, decide 
where to store the report and under what name, and click the "OK" button. 
 
See also: How to create customized reports 
 



Chamber report parameter names 
 

Stop code: [PARAM:StopCode] 
Profile name: [PARAM:Testname] 
Sample Frequency: [PARAM:SampleFrequency] 
Repeats: [PARAM:Repeats] 
Annotation line 1: [PARAM:Note1] 
Annotation line 2: [PARAM:Note2] 
Annotation line 3: [PARAM:Note3] 
Data directory: [PARAM:DataDirectory] 
Data storage settings: [PARAM:DataStorage] 
Segment table: [PARAM:SegmentTable] 
Start time: [PARAM:StartTime] 
Current time: [PARAM:Time] 
Elasped Time: [PARAM:ElapsedTime] 
Remaining: [PARAM:Remaining] 
Channel vibration: [PARAM:Ch1Vib] 
 [PARAM:Ch2Vib] 
 [PARAM:Ch3Vib] 
 [PARAM:Ch4Vib] 
 [PARAM:Ch5Vib] 
 [PARAM:Ch6Vib] 
 [PARAM:Ch7Vib] 
 [PARAM:Ch8Vib] 
Channel fatigue: [PARAM:Ch1Fat] 
 [PARAM:Ch2Fat] 
 [PARAM:Ch3Fat] 
 [PARAM:Ch4Fat] 
 [PARAM:Ch5Fat] 
 [PARAM:Ch6Fat] 
 [PARAM:Ch7Fat] 
 [PARAM:Ch8Fat] 
Chan Accum fatigue: [PARAM:Ch1AFa] 
 [PARAM:Ch2AFa] 
 [PARAM:Ch3AFa] 
 [PARAM:Ch4AFa] 
 [PARAM:Ch5AFa] 
 [PARAM:Ch6AFa] 
 [PARAM:Ch7AFa] 
 [PARAM:Ch8AFa] 
Channel humidity: [PARAM:Ch1Hum] 
Product temperature: [PARAM:Ch1Temp] 
Air temperature [PARAM:Ch2Temp] 
Vibration Label [PARAM:La1Vib] 
 [PARAM:La2Vib] 
 [PARAM:La3Vib] 
 [PARAM:La4Vib] 
 [PARAM:La5Vib] 
 [PARAM:La6Vib] 
 [PARAM:La7Vib] 
 [PARAM:La8Vib] 
Humidity Label:  [PARAM:La1Hum] 
Temperature Label: [PARAM:La1Temp] 
 [PARAM:La2Temp] 



 
Calibration data [PARAM:Cal1] 
 [PARAM:Cal2] 
 [PARAM:Cal3] 
 [PARAM:Cal4] 
 [PARAM:Cal5] 
 [PARAM:Cal6] 
 [PARAM:Cal7] 
 [PARAM:Cal8] 
Vibration units: [PARAM:UnitViberation] 
Density units [PARAM:UnitDensity] 
Humidity units: [PARAM:UnitHumidity] 
Temperature units: [PARAM:UnitTemperature] 
Velocity units: [PARAM:UnitVel] 
Displacement units: [PARAM:UnitDisplacement] 
 
 
 
Chamber report graph types 
 
Graph types for Repetitive reports may be one of the following: 
 
[GRAPH:Temp]  Temperature vs Time 
[GRAPH:Vib] Vibration rms Amplitude vs Time 
[GRAPH:Fatigue] Fatigue rate vs. Time 
[GRAPH:PSD] Power Spectral Density 
[GRAPH:Sigma] Rate vs Amplitude 
[GRAPH:Time] Accel waveform 
[GRAPH:Vel] Velocity waveform 
 
 
Flags that may be applied to enable traces: 
 
Ch1 Channel 1 
Ch2 Channel 2 
Ch3 Channel 3 
Ch4 Channel 4 
Ch5 Channel 5 
Ch6 Channel 6 
Ch7 Channel 7 
Ch8 Channel 8 
Con SetPoint 
Dem Process Variable 
 
Flags that may be applied to set the formatting of the graph: 
 
W150 Select graph width, in mm (default is 150) 
H100 Select graph height, in mm (default is 100) 
LogX Use a logarithmic horizontal axis (default is linear) 
LogY Use a logarithmic vertical axis (default is linear) 
BW Create a black-and-white plot (default is color) 
 
Example: 
 
[GRAPH:PSD,Ch1,Ch2,LogX,LogY,BW] 
 



Print Report Command (File Menu) 
 
This command will create a report using the same templates that the Create Report Command 
uses but instead of storing it, the report will be printed on the default printer. 
 
To print a report, select the File..Print Report menu command, choose a template and click the 
"OK" button. 
 
See also: How to create customized reports 
 
Print Active Graph command (File menu) 
 
Use this command to print a graph to the printer.  A printer selection dialog box (see Printer Setup 
for a description of this dialog) will be presented, allowing selection of the printer and layout 
options.  See also the Printer Setup and the Print Options menu commands. 
 
Shortcuts 

Toolbar:  
Keys: Ctrl+P 
 

Printer Setup..command (File menu) 
 
The following options allow you to select destination printer and its connection.  Changes made 
using this command will be used as the default settings for all subsequent Print commands. 
 
Name 

Select the printer you want to use.  Select the Default Printer; or select the Specific Printer 
option and select one of the current installed printers shown in the dialog box.  You can install 
printers and configure ports using the Windows Control Panel.  

Properties 
Displays a dialog box where you can make additional choices about printing, specific to the 
type of printer you have selected. 

Paper Size 
Select the size of the paper on which the document is to be printed. 

Paper Source 
Some printers offer multiple trays for different paper sources.  Specify the tray here. 

Orientation 
Select Portrait or Landscape. 

 



Print Options command (File menu) 
 
This command brings up the Print Parameters dialog box that may be used to change the way 
graphs are printed. 
 

 
 
The following settings may be made: 
 
Graph Window Background 

If this box is checked, the background color of a graph is printed otherwise it is ignored.  By 
default this box is not checked. 

Plotting Area Background 
If this box is checked, the background color of a graph's plotting area is printed otherwise it is 
ignored.  By default this box is not checked. 

Border 
If this box is checked, a graph is printed with a rectangular border around it.  By default this 
box is not checked. 

Maintain Aspect Ratio 
If this box is checked, the aspect ratio is maintained when printing with Print graphs to max 
size and Proportionate printing styles.  Otherwise the graph is mapped to the full printed 
page, and the aspect ratio may change.  By default this box is checked. 

Upper Left Corner 
X- and Y-position of the left-upper corner of the page relative to the paper sheet width.  A Left 
value of 0.0 indicates that the page will be printed starting at the left side of the paper sheet.  
A Top value of 0.0 indicates that the page will be printed starting at the left side of the paper 
sheet.  This parameter is only used if the Exact Size printing style is selected. 

Print graphs to max size 
Proportionate 

(These two options are equivalent for graphs printed by StarVIEW.) 
Print the graphs with the maximal size that a paper sheet allows.  These options will scale the 
text and symbols so that their size relative to other objects remains constant. 

Exact Size 
Printed graphs will maintain their original sizes.  Only this option guarantees that text and 
symbols will be printed with their specified size. 
 

Explorer Command (File Menu) 
 
This command will open a Windows Explorer window to allow you to copy/move/rename files. 
 



Exit command (File menu) 
 
Use this command to end your StarVIEW session.  You can also use the Close command on the 
application system menu. 
 
Shortcuts 

Mouse: Click the X in the upper right corner of the StarVIEW window: 

  
 Or: Double-click the application's system menu. 

  
Keys: Alt+F4 
 

Configuration menu commands 
 
The configuration menu is used to set the characteristics and limits of the shaker system.  It offers 
the following commands: 
 
Parameters General system configuration parameters entered here. 
Remote Inputs Configure the Remote Input options here. 
System Calibration Laboratory calibration performed here. 
Channel Label Define default channel labels 
Accelerometer Sensitivity Enter the mV/g levels here. 
Units Select units to use in the program. 
Controller PID Adjust PID settings for loop controller. 

 
Parameters command (Configuration menu) 
 
This command opens the Parameters tab on the StarVIEW Configuration dialog box. 
 
Use this command to enter general controller parameters such as I/O hardware and serial port 
number. 
 
 
Remote Inputs command (Configuration menu) 
 
This command opens the Remote Inputs tab on the StarVIEW Configuration dialog box. 
 
Use this command to enable and configure the Remote Input options. 
 
Channel Labels command (Configuration menu) 
 
This command opens the Channel Label tab on the StarVIEW Configuration dialog box. 
 
Use this command to enter new default channel labels to be used in new tests. 
 
This command will also change the labels for the currently selected test, Test/Edit Test, then 
press Save As button to make changes permanent. 
 
 
System Calibration command (Configuration menu) 
 
This command brings up the System Calibration tab on the StarVIEW Configuration box. 



 
This command is used to calibrate the input scaling factors and offsets, the output scaling factor. 
 
Accelerometer Sensitivity command (Configuration menu) 
 
This command brings up the Accelerometer Sensitivity tab on the StarVIEW Configuration dialog 
box. 
 
Use this command to enter the sensitivity values associated with each of your accelerometers. 
You should use the sensitivity values assigned by the calibration laboratory. 
 
Units command (Configuration menu) 
 
This command brings up the System Units tab on the StarVIEW Configuration dialog box. 
 
Use this command to select and define the desired units to be used by the program. 
 



PID command (Configuration menu) 
 

 
 
 
Use Get Parameters Pushbutton to retrieve parameters for loop controller 
Enter modified values into respective boxes 
Use Send Parameters Pushbutton to accept modified values and send to loop controller 
 



Watlow PID Tuning 
 
Proportional Band: Define a band for PID control, entered in degrees or 
units. 
 Lower values increase gain, which reduces droop but can cause 
oscillation. 
Increase the proportional band to eliminate oscillation. 
 
Integral (Reset): Define the integral time in minutes per repeat; define 
reset in repeats per minute.  
Set repeats per minute if units are U.S.minutes per repeat if units are 
SI. 
 
Derivative (Rate): Define the derivative (rate) time in minutes.  
Large values prevent overshoot but can cause sluggishness.  
Decrease if necessary. 
 



Test menu commands 
 
The test menu is used to select, load, save, start, and stop tests.  It offers the following 
commands: 
 
Select Test Type Select Chamber type test. 
Run Test Start running the current test. 
Stop Test Stop the current test. 
Advance to next level Skip to the beginning of the next level. 
Test Schedule Create and run a list of tests to run in sequence. 
  
New Test Create a new test profile. 
Open Test Open an existing test profile. 
Open Recent Test Submenu displays recently used test 
Edit Test Edit the current test. 
  

 
Select Test Type command (Test menu) 
 
Use this command to select type of test you will be running.  The StarVIEW Test Type dialog box 
will appear, allowing selection of the test type.  The different test types are software options that 
are protected by a hardware key.  If your hardware key does not have an option enabled, you will 
still be able to switch to that mode, define profiles, and load and plot data sets, but you will not be 
able to run the test. Contact Vibration Research Corp. for information on options that are not 
enabled. 
 
Shortcuts 

Toolbar:  
 



Run Test command (Test menu) 
 
Use this command to start the current test.  See also: Stop Test 
 
Shortcuts 

Toolbar:  

Controls:  
Keys: F9 
 

Stop Test command (Test menu) 
 
Use this command to stop any running test.  See also: Run Test 
 
Shortcuts 

Toolbar:  

Controls:  
Keys: F10 

 



Advance to next level command (Test menu) 
 
Use this command while a test is running to skip the remaining time in the current level, and to 
begin the next level.  Levels are defined in the "Schedule..." option of the Edit Test dialogs. 
 
Shortcuts 

Keys: F11 
 

Test Schedule command (Test menu) 
 
Use this command to build a schedule of tests.  To create a test schedule, first define the tests, 
and then use this command to bring up the Test Schedule dialog box to add the tests to the test 
sequence. 
 
The tests will be run in the defined order, with each test running for the duration specified within 
the individual test's schedule.  There will be a pause of approximately 5 seconds between each 
test. 
 
The schedule will be aborted if a test is shut down prior to completion of the schedule.  (For 
example, if the operator presses the "Stop" button, or a test encounters an error condition.) 
 
New Test command (Test menu) 
 
Use this command to have the program guide you through a series of dialog boxes to define a 
new test.  All values are initialized to their defaults, and may then be changed as required by your 
test. 
 
If your new test is substantially similar to another test you have already defined, open a similar 
test using the Test..Open Test menu command, and then use the Test..Edit Test menu command 
to bring up the Define Test dialog.  Use the "Save As..." button in that dialog box to save the test 
under a new name. 
 
Shortcuts 

Toolbar:  
 
Open Recent Test command (Test menu) 
 
This command brings up a pop-up submenu with a list of the 10 most recently used tests.  To 
open one of the tests listed, click on it with the mouse. 
 



Open Test command (Test menu) 
 
Use this command to open any previously defined and saved test profile. 
 
Shortcuts 

Toolbar:  
 
 
Edit Test command (Test menu) 
 
This command opens the Define Test dialog box allowing the user to edit the currently loaded 
test. 
 
You can also open a previously defined test, or save the test under a different name from the 
Define Test dialog. 
 
Depending on which test type is currently active, one of the following Define Tests dialog boxes 
will be opened: 
 

 Repetitive Shock Define 
Shortcuts 

Toolbar:  
 
Graph Colors command (Graph menu) 
 
Use this command to bring up the Graph Colors dialog box that may be used to customize the 
colors of your graphs. This will only affect graphs created after changing the colors; already open 
graphs will retain the old settings.  To update the colors on any already-open graph, select the 
graph and press Ctrl+G (Edit Graph Settings command), and click the "OK" button. 
 
Pause Graph Updates (Graph menu) 
 
Use this command to manually pause or resume the automatic graph refreshes.  This is most 
useful in Field Data Replicator mode because it allows the operator to closely examine the 
demand and control waveforms. 
 
Shortcuts 

Keys: Ctrl+P 
 



Edit Graph Settings command (Graph menu) 
 
Use this command to open the Graph Settings dialog box appropriate for the currently selected 
graph.  You may then modify the type of graph, the traces displayed on the graph and the axis 
settings. Click the "OK" button to have the graph rebuilt with these new settings. 
 
See also: 
 

 Repetitive Shock Graph Settings dialog box 
  

Shortcuts 

Toolbar:  
Keys: Ctrl+G 
 

Y-Axis Autoscale command (Graph menu) 
 
Use this command to automatically set the vertical (Y-axis) scale such that the data shown in the 
current plot fits on the display. 
 
See also: Full Autoscale 
 
Shortcuts 

Keys: Ctrl+A 
 

Full Autoscale command (Graph menu) 
 
Use this command to automatically set both horizontal and vertical axis scales such that the 
traces of the selected graph fit on the screen. 
 
See also: Y-Axis Autoscale 
 
Note: You can zoom into a region of the graph by clicking with the right mouse button on one 
corner of the desired view, holding the button down while moving the mouse to enclose the 
desired region, and then releasing the right mouse button. 
 
Shortcuts 

Toolbar:  
Keys: Ctrl+F 
Mouse: Double-click the right mouse button 
 

Refresh Graph command (Graph menu) 
 
Use this command to redraw the selected graph. 
 
Shortcuts 

Keys: F5 
 



Cursor Display command (Graph menu) 
 
Use this command to bring up the Cursor Display box that shows the values for the graph traces 
at the current cursor position. 
 
Holding down the <Shift> key while moving the cursor with the mouse snaps the cursor to the 
nearest peak. 
 
Holding down the <Ctrl> key while moving the cursor with the mouse snaps the cursor to the 
nearest valley. 
 
Shortcuts 

Keys: Ctrl+D 
 

Add Annotation command (Graph menu) 
 
Use this command to annotate the current graph with the trace values at the current cursor 
position.  To display a vertical cursor bar to help with selection of data, turn on the cursor display 
using the Graph..Cursor Display menu command. 
 
Tips: 

 To accurately place an annotation, first use the right mouse button (click, drag, release) to 
zoom in on the region of interest.  Add the annotation by positioning the cursor and pressing 
the <Insert> key.  Zoom out by double-clicking the right mouse. 

 To move an annotation, click on the annotation with the left mouse button, hold the button 
down, move the mouse to the new location, and release the left mouse button. 

 Holding down the <Shift> key snaps the cursor to the nearest peak.  Press the <Insert> key 
while holding down the <Shift> key to put an annotation at the location of the peak. 

 Holding down the <Ctrl> key snaps the cursor to the nearest valley.  Press the <Insert> key 
while holding down the <Ctrl> key to put an annotation at the location of the valley. 

 After creating an annotation you can double-click it (using the left mouse button) to edit the 
text. 

 
See also: Cursor Display, Remove Annotation, Move Annotation 
 
Shortcuts 

Keys: Insert 
 F8 
 Shift-Insert Insert annotation at the nearest peak 
 Ctrl-Insert Insert annotation at the nearest valley 

 
Remove Annotation command (Graph menu) 
 
Use this command to remove the currently selected annotation.  First click on the annotation (a 
black rectangle will briefly encircle the text) and then use this command to remove the annotation. 
 
See also: Add Annotation, Move Annotation 
 
Shortcuts 

Keys: Delete 
 F7 
 



Move Annotation command (Graph menu) 
 
Use this command to change the position of the currently selected annotation.  First click on the 
annotation text (a black rectangle will briefly encircle the text), and then use this command to start 
the move.  Move the mouse pointer to the desired location for the annotation, and click the left 
mouse button to complete the move. 
 
Tip: You can also move an annotation by pointing to the annotation text with the mouse, clicking 
the left mouse button, holding that button down while moving the mouse cursor to the desired 
location and releasing the button to complete the move. 
 
See also:  Add Annotation, Remove Annotation 
 
Shortcuts 

Mouse: Click and drag the annotation 
Keys: F4 
 

View menu commands 
 
The View menu offers the following commands: 
 
Toolbar Show or hide the toolbar. 
Status Bar Show or hide the status bar. 
Control buttons Show or hide the active Control Center 
  
Reset Control buttons Reset the control window to the default location 
  
ToolTips View ToolTips 
  
Big Display Enable Big display of Process Variables and Setpoints 

 
Toolbar command (View menu) 
 
Use this command to show or hide the Toolbar that includes buttons for some of the most 
common commands in StarVIEW, such as the File..Open Data menu command.  A check mark 
appears next to the menu item when the Toolbar is shown. 
 
See Toolbar for help on using the toolbar. 
 



Status Bar command (View menu) 
 
Use this command to show or hide the Status Bar that describes the action to be executed by the 
selected menu item or depressed toolbar button and keyboard latch state. A check mark appears 
next to the menu item when the Status Bar is shown. 
 
See Status Bar for help on using the status bar. 
 
Control buttons command (View menu) 
 
Use this command to show or hide the active Control Center that contains buttons for starting and 
stopping tests, and also contains the current test measurements.  A check mark appears next to 
the menu item when the Control Center is shown. 
 
See the following for help on the various Control Centers: 
 

 Chamber Control Center 
 Repetitive Shock Control Center 

 
Reset Control buttons command (View menu) 
 
Use this command to reset the size and position of the Control Center that contains buttons for 
starting and stopping tests, and also contains the current test measurements.  Use this command 
if you accidentally move the Control Center to the edge of the screen and aren't able to select it to 
move it. 
 
ToolTips command (View menu) 
 
Use this command to enable or disable display of tooltips in the toolbar and the Control Centers.  
A tooltip is a small window that displays context sensitive help information when you point the 
mouse at a button on the toolbar.  A check mark appears next to this menu item when tooltips are 
enabled. 
 
Window menu commands 
 
The Window menu offers the following commands that allow you to arrange multiple views of 
multiple documents in the application window: 
 
New Window Create a new window that views the same document. 
Cascade Arrange windows in an overlapped fashion. 
Tile Horizontal Arrange windows in non-overlapped tiles, horizontally. 
Tile Vertical Arrange windows in non-overlapped tiles, vertically. 
Arrange Icons Arrange icons of closed windows. 
Window 1, 2, ... Go to specified window (graph). 

 



Big Display dialog box (View Menu) 
 

 
 
Click on the large numbers with the RIGHT mouse button to configure the display. 

 
 
 
New Window command (Window menu) 
 
Use this command to open a new window with the same data as the active window.  You can 
open multiple document windows to display different views of a data set at the same time.  If you 
change the contents in one window, all other windows containing the same data set reflect those 
changes.  When you open a new window, it becomes the active window and is displayed on top 
of all other open windows. 
 
 



Cascade command (Window menu) 
 
Use this command to arrange multiple open windows in an overlapped fashion.  
 
 
Tile Horizontal command (Window menu) 
 
Use this command to arrange multiple open windows in a non-overlapping fashion, with the 
preference being that the graphs be stacked one above the other in a horizontal fashion. 
 
Tile Vertical command (Window menu) 
 
Use this command to arrange multiple open windows in a non-overlapping fashion, with the 
preference being that the graphs be stacked one beside the other in a vertical fashion. 
 
Arrange Icons command (Window menu) 
 
Use this command to arrange the icons for minimized windows at the bottom of the main window.  
If there is an open document window at the bottom of the main window, then some or all of the 
icons may not be visible because they will be underneath this document window. 
 
1, 2,..command (Window menu) 
 
StarVIEW displays a list of currently open document windows at the bottom of the Window menu.  
A check mark appears in front of the document name of the active window.  Choose a document 
from this list to make its window active.   
 
Help menu commands 
 
The Help menu offers the following commands that provide you assistance with this application:  
 
Help Open the help file to the overview page 
Contents and Index Offer you an index to topics for which you can get help 
What's This? Use this to get context-sensitive help information. 
About StarVIEW... Display application information. 

 
Help command (Help menu) 
 
Use this command to display the opening screen of Help.  From the opening screen, you can 
jump to step-by-step instructions for using StarVIEW and various types of reference information.   
 
Once you open Help, you can click the "Contents" button whenever you want to return to the 
opening screen. 
 
Shortcut 

Toolbar:  
Keys: F1 
 

Contents and Index command (Help menu) 
 
Use this command to open the help file's table of contents, index, and search functions.  You can 
browse through or search the help file for information on a particular subject. 
 
What's This? command (Help menu) 



 
Use the Context Help command to obtain help on some portion of StarVIEW.  When you choose 
the Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.  
Then click somewhere in the StarVIEW window, such as another Toolbar button or menu item.  
The Help topic for the item you clicked will be shown. 
 
Shortcut 

Toolbar:  
Keys: Shift+F1 

 
About command (Help menu) 
 
Use this command to display the copyright notice and version number of your copy of StarVIEW. 
 



Control Centers 
 
 
Chamber Define dialog box 

 
This dialog box is accessed by selecting the Test..Edit Test menu command. 
 
 
The Test is defined as a sequence of steps with a duration and an ending setpoint for 
temperature, vibration, and humidity 
 
The first step has the initial setpoint values assignment in the left entries.. 
 
Each additional step linearly increments from the ending setpoint of the previous step to the 
entered setpoint entered in the right entries. 
 
To have the program automatically compute the Duration  Enter the ending Temperature and 
Vibration.  If the values are different from the starting temperature and vibration the far right 
columns will be enabled (white).  Enter a rate into the box and the system will recalculate the 
duration based on the entered rate. 
 
Actions: 

NORM Normal Step will linearly ramp from initial values in left columns to final values in right columns over time p
Duration 

SHORT Short Steps will advance the time if the process variable is outside the Soak Setpoint Window.  Use SHOR
temperature changes 

G.SOAK G.SOAK holds the current setpoint while the process variable is outside the Setpoint Window.  Use G.SOA
temperature soak periods. 

LOOP LOOP is a special step which repeats previous steps.  Loops are specified as loop back step (from) and n
the steps. 

 
Insert button inserts a step below the step indicated with a double arrow right of the index number 
Delete button deletes the step indicated with a double arrow right of the index number 
 



Graph 
The graph displays Temperature, Humidity, or Vibration setpoints.  Click on the arrow to the right 
of the text at top of graph to change displayed graph. 
 
 
 
Discrete Outputs Define discrete outputs turned on for each sequence step. 
Parameters Enter control loop parameters. 
Channels Define and Label spectrum channels. 
Data Store Select automatic data storage parameters. 

 
The buttons at the bottom of the dialog box perform the following operations: 
 
Save As... Save the current settings under a new test name. 
OK Save the changes to this test, and close the dialog 
Cancel Close the dialog box and abandon all changes 
Apply Apply the changes to the currently running test (does not save changes 

to the hard disk). 
Help Get help information about these parameters. 

 
 
Chamber Define Discrete Outputs tab 
 

 
Step Action displaces the sequence of steps previously defined. 
 
Click on pushbutton to toggle the output state on or off for the respective step. 
 
 

 
If the pushbutton is pressed  the output will turn on at the start of the step and remain 
on the entire step 

 
If the pushbutton is off the output will turn off at the start of the step and remain off the 
entire step 

If the pushbutton is pressed  the output will turn on at the start of the step and remain on the 
entire step 
If the  
 



Graph 
The graph displays Temperature, Humidity, or Vibration setpoints.  Click on the arrow to the right 
of the text at top of graph to change displayed graph. 
 
 
 
Define Define a sequence of steps. 
Parameters Enter control loop parameters. 
Channels Define and Label spectrum channels. 
Data Store Select automatic data storage parameters. 

 
The buttons at the bottom of the dialog box perform the following operations: 
 
Save As... Save the current settings under a new test name. 
OK Save the changes to this test, and close the dialog 
Cancel Close the dialog box and abandon all changes 
Apply Apply the changes to the currently running test (does not save changes 

to the hard disk). 
Help Get help information about these parameters. 

 
Chamber Define Data Storage tab 

 
 
This dialog box is accessed by clicking the "Data" tab on the Chamber Define dialog box. 
 
 
 
Use this dialog box to enable automatic data saving to disk.  You can save the data at the end of 
a level, at the end of a test, at the end of a sweep, or at the end of a time period.  All data is 
saved as a time stamped file, and can be viewed at a later time by selecting the Window..New 
window..Stored data graph display menu command. 
 
You may also select the directory into which to store the data.  Click the "Copy from test name" 
button to automatically create an output directory based on the name of the current test. 
 
 
The Graph annotation lines are displayed on the Data Bottom portion of a graph (if Data Bottom 
is selected for the graph) and also will appear in reports generated from this test data. 



Graph 
The graph displays Temperature, Humidity, or Vibration setpoints.  Click on the arrow to the right 
of the text at top of graph to change displayed graph. 
 
 
 
Define Define a sequence of steps. 
Parameters Enter control loop parameters. 
Channels Define and Label spectrum channels. 

 
The buttons at the bottom of the dialog box perform the following operations: 
 
Save As... Save the current settings under a new test name. 
OK Save the changes to this test, and close the dialog 
Cancel Close the dialog box and abandon all changes 
Apply Apply the changes to the currently running test (does not save changes 

to the hard disk). 
Help Get help information about these parameters. 

 
 
Chamber Define Parameters tab 
 

 
This dialog box is accessed by clicking the "Parameters" tab in the Chamber Define dialog box. 
 
 

Sample Frequency Number of scans of each samples channel per second 
Number of Samples Total Number of samples collected for each channel 
Repeats Repeat count for entire sequence 
Guar Soak -Window Maximum deviation below setpoint for process variable during 

guarantied soak step 
Guar Soak +Window Maximum deviation above setpoint for process variable during 

guarantied soak step 
Material Beta Material Beta used with Miner's Rule Fatigue calculation 
Calculate Fatigue Using Calculate fatigue using velocity or acceleration. 
Temperature Loop Mode Optionally Cascade Air Temperature from Product 

Temperature. 
PSD Averaging Entered Number is percentage weighting of previous readings.  

99% is maximum averaging, 0% for Averaging OFF 
 
 



 
Graph 
The graph displays Temperature, Humidity, or Vibration setpoints.  Click on the arrow to the right 
of the text at top of graph to change displayed graph. 
 
 
 
Define Define a sequence of steps. 
Discrete Outputs Define discrete outputs turned on for each sequence step. 
Channels Define and Label spectrum channels. 
Data Store Select automatic data storage parameters. 

 
The buttons at the bottom of the dialog box perform the following operations: 
 
Save As... Save the current settings under a new test name. 
OK Save the changes to this test, and close the dialog 
Cancel Close the dialog box and abandon all changes 
Apply Apply the changes to the currently running test (does not save changes 

to the hard disk). 
Help Get help information about these parameters. 

. 
 
Chamber Define Channels tab 

 
This dialog box is accessed by clicking the "Channels" tab in the Chamber Define dialog box. 
 
Vibration Channels 
Channels with a check mark have full spectrum data collection 
Channels without a check mark are ignored. 
Channels can be labeled individually for this specific test. 
 
Control From Vibration Channels 
Any or all active vibration channels can be retransmitted on the analog output channel as a DC 
voltage. 
If multiple channels are checked they are averaged, then retransmitted. 
The output format is defined by channel 1 accelerometer sensitivity. 
Example: 
If channel 1 input is 10mV/G the output will be 10mV/(Grms). (0VDC = 0Grms, 5VDC=500Grms) 
If channel 1 input is 100mV/G the output will be 100mV/(Grms). (0VDC=0Grms, 5VDC=50Grms) 
 
 



 
 
Graph 
The graph displays Temperature, Humidity, or Vibration setpoints.  Click on the arrow to the right 
of the text at top of graph to change displayed graph. 
 
 
 
Define Define a sequence of steps. 
Discrete Outputs Define discrete outputs turned on for each sequence step. 
Parameters Enter control loop parameters. 
Data Store Select automatic data storage parameters. 

 
The buttons at the bottom of the dialog box perform the following operations: 
 
Save As... Save the current settings under a new test name. 
OK Save the changes to this test, and close the dialog 
Cancel Close the dialog box and abandon all changes 
Apply Apply the changes to the currently running test (does not save changes 

to the hard disk). 
Help Get help information about these parameters. 

 
 



Configuration dialog 
 

 
 
Use this dialog box to set global system parameters including the type of I/O hardware and the 
serial port used by the controller. 
 
The emergency stop input is an optional feature (part of the Remotef Input package). 
 
See Also: 
How to install the Hardware 
How to install the software 
 
 



Remote Inputs dialog box 
 
This dialog box is accessed by selecting the Configuration..Remote Inputs menu command. 
 

 
 
Use this dialog box to enable and configure the remote input option.  Note: Remote Input is an 
optional feature that requires that the software key be programmed at the factory.  If you haven't 
purchase the remote input option, you may ignore this configuration dialog box. 
 
Discrete Input 0: Remote Start/Stop Signal 
 
The Remote Input options allow a remote TTL level input signal to start and stop the test.  To use 
this feature, connect the remote input signal to Discrete Input 0 on the back of the StarVIEW IO 
unit.  Then enable remote input by selecting "Enabled" next to the Remote Start/Stop label of the 
above dialog (in the upper left corner of the dialog). 
 
Once this feature has been enabled, the test may be started and stopped using a remote input.  
When the input signal to Discrete Input 0 makes a transition from 0 volts to +5 volts, the test will 
start.  When the input signal to Discrete Input 0 makes a transition from +5 volts to 0 volts, the 
test will stop. 
 
You may also operate the remote input through a relay, using the relay to switch the Discrete 
Input 0 signal between +5V and ground. 
 
Discrete Input 1: Emergency Stop Signal 
 
The emergency stop input is an optional feature (part of the Remote Input package) that connects 



to Digital Input 1 on the rear of the StarVIEW I/O unit.  When this input is low (below 2 volts) the 
outputs of the I/O unit are immediately brought to 0 volts to stop the drive signal going to the 
amplifier.  Typically this input is connected to +5V through a normally closed red mushroom 
button.  When the mushroom button is pressed, the connection to +5V is opened and Digital Input 
1 is pulled to ground by a pull-down resistor inside the StarVIEW I/O unit.  This causes the shaker 
drive signal to be immediately shut down. 
 
Discrete Inputs 4,5,6,7: Remote Test Selection 
 
When Remote Selection is enabled in the above dialog box (upper right corner of the dialog), a 
test is automatically loaded when the remote input signal is used to start a test.  This may be 
used to select different tests using remote electronics such as a PLC.  Remote test selection is 
performed using discrete inputs 4, 5, 6, 7 according to the following table, where a 0 and 1 
indicate TTL voltage levels of 0 volts and 5 volts, respectively (threshold level is 2.2 volts).  For 
each test number listed in the table below, there is a corresponding line in the Remote Input 
configuration dialog box configuring the name of the test to load. 
 
DI7 DI6 DI5 DI4 Test number 
0 0 0 0 0 
0 0 0 1 1 
0 0 1 0 2 
0 0 1 1 3 
0 1 0 0 4 
0 1 0 1 5 
0 1 1 0 6 
0 1 1 1 7 
1 0 0 0 8 
1 0 0 1 9 
1 0 1 0 10 
1 0 1 1 11 
1 1 0 0 12 
1 1 0 1 13 
1 1 1 0 14 
1 1 1 1 15 

 
Note: In Standalone-Mode (a special operating mode that may be enabled at the factory), the 
remote test selection is also loaded when the start switch on the front of the StarVIEW I/O unit is 
used to start a test. 
 



System Calibration dialog box 
 
This dialog box is accessed by selecting the Configuration..System Calibration menu command. 
 

 
 
 
Wait for operator dialog box 
 
This dialog box appears when the test is running, and it reaches a "Wait for operator" level in the 
test schedule.  The test will pause until the operator clicks either the "Continue" button in this 
dialog box, or the "Run" button in the Control Center. 
 

 
 
Clicking either the "Abort test" button in this dialog box, or the "Stop" button in the Control Center 
will abort the current test. 
 
 



Accelerometer Sensitivity dialog box 
 
This dialog box is accessed by selecting the Configuration..Accelerometer Sensitivity menu 
command. 
 

 
 
Use this dialog box to enter the calibrated sensitivity ratings for your accelerometers in mV/G. 
 



System Units dialog box 
 
This dialog box is accessed by selecting the Configuration..Units menu command. 
 

 
 
Use this dialog box to select and define the desired units to be used by the program.  Changing 
the units will stop any active test. 
 
Select the desired units for Acceleration, Velocity, Displacement, Force, Mass and Acceleration 
Spectral Density.  If the listed units are not appropriate for your test, custom units may be defined 
by entering a label in the upper box (between the 1 and the =), and the appropriate scaling factor 
from the SI unit in the lower box.  The unit label and scale factor must make the equation correct.  
For example: 
 1 oz = 0.02835 kg 
 



System Check Graph 
 
Use the Graph..Edit Graph menu command to change the settings of this graph. 
 
StarVIEW Test Type dialog box 
 
This dialog box is accessed by selecting the Test..Select Test Type menu command or by 

clicking   on the toolbar. 
 
 
The different test types are software options that are protected by a hardware key.  If your 
hardware key does not have an option enabled, you will still be able to switch to that mode, define 
profiles, and load and plot data sets, but you will not be able to run the test. 
 
Contact Vibration Research Corp. for information on options that are not enabled. 
 
 



Test Schedule dialog box 
 
This dialog box is accessed by selecting the Test..Test Schedule menu command. 
 

 
 
Use this dialog box to build a schedule of tests to run in sequence.  The tests will be run in the 
listed order, with each test running for the duration specified within the individual test's schedule.  
There will be a pause of approximately 5 seconds between each test. 
 
The schedule will be aborted if a test is shut down prior to completion of the schedule.  (For 
example, if the operator presses the "Stop" button, or a test encounters an error condition.) 
 
Click the "Run Schedule" button to run all tests beginning with the first test.  If you want to start 
the schedule at a specific test, first select that test, and then click the "Run Schedule" button. 
 
To add programs to the test schedule, select the test you want the new test to follow, and click 
the "Add Program" button.  You will be prompted for a test name.  When you click the "Open" 
button, that test will be added to the schedule. 
 
To remove programs from the test schedule, select the test you want to remove, and then click 
the "Delete Program" button.  Click the "Delete All" button to clear all entries in the list. 
 
To repeat a sequence of tests multiple times, select the last test you want in the repeat sequence, 
and then click the "Add Loop" button.  A Schedule Loop dialog will appear prompting you for the 
first test in the sequence and the number of times you want the sequence performed. 
 
To change the settings of an existing loop, select loop in the schedule, and then click the "Add 
Loop" button. 
 
Test schedules may be saved on the hard disk by clicking the "Save As..." button, and later 
loaded back in by clicking the "Load..." button. 
 
 



Schedule Loop dialog box 
 
This dialog box is accessed by clicking the "Add Loop" button in the StarVIEW Test Schedule 
dialog box. 
 

 
 
Enter the test number of the first test in the sequence in the "Loop from" entry, and then the total 
number of times you want the sequence of tests performed in the "Do loop" entry.  Then click the 
"OK" button to enter the loop parameters into the test schedule 
 
 
Cursor Display dialog box 
 
This dialog box is accessed by selecting the Graph..Cursor Display menu command. 
 

 
 
This dialog box will display the values of the graph data at the cursor position in the currently 
selected graph.  The parameters displayed will be specific to the selected graph. 
 



Graph Colors dialog box 
 
This dialog box is accessed by selecting the Graph..Graph Colors menu command. 
 

 
 
Use this dialog box to set the default colors for various components of the graphs. 
 
Changes made here will only affect graphs created after changing the colors - already open 
graphs will retain the old settings.  To update the colors on any already-open graph, select the 
graph, press Ctrl+G (Edit Graph Settings command), and then click the "OK" button. 
 
Graph Update Time dialog box 
 
This dialog box is accessed by selecting the Graph..Graph Update Time menu command. 
 

 
 
The value specified here is the number of milliseconds between graph updates.  The default 
value is 1000 ms (i.e. 1 second). 
 
Wait message 
 
This dialog box indicates that a file transfer is in progress, and provides feedback to the user as 
to how much remains before the transfer is complete.  Please wait until this dialog disappears 
before continuing. 
 



Message dialog box 
 
This dialog box is used to provide status information for an operation that may take more than a 
couple of seconds. 
 
Password Entry dialog box 
 
This dialog box appears whenever a password-protected operation is performed.  Type in the 
password, and click the "OK" button to continue. 
 

 
 
A sheet of paper with the password instructions was attached to the manual you received with 
your system.  Contact Vibration Research Corporation (616-669-3028) if you have forgotten the 
password. 
 
Note:  Use the following procedure to disable the password protection feature of the program: 
 

38. Open the file 'C:\Program Files\StarVIEW\chamber.ini' using Notepad 
39. Find the section labeled [Password] 
40. This section should have two lines: 
Calibrate=ThePasswordHere 
Program=ThePasswordHere 
41. Enter the passwords in either or both lines, in place of ThePasswordHere, and save the 

shaker.ini file. 
 
The Program password is used to protect the test profiles from unauthorized or inadvertent 
changes. 
The Calibrate password is used to protect the system calibration dialog box from unauthorized 
changes. 
 
Notice Message dialog box 
 
This dialog box is used to provide a variety of notice messages.  The dialog box will stay open 
until the "OK" button is pressed, but will not interrupt normal program operation. 
 
Restore command (Control menu) 
 
Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command. 
 



Move command (Control menu) 
 
Use this command to display a four-headed arrow that allows you to move the active window or 
dialog box with the arrow keys. 

 
 
Note:  This command is unavailable if you maximize the window. 
 
Shortcut 

Keys: CTRL+F7 
 
Size command (System menu) 
 
Use this command to display a four-headed arrow that allows you to resize the active window 
with the arrow keys. 

 
 
After the pointer changes to the four-headed arrow: 

42. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 
to the border you want to move.   

43. Press a DIRECTION key to move the border. 
44. Press ENTER when the window is the size you want. 

 
Note:  This command is unavailable if you maximize the window. 
 
Shortcut 

Mouse: Drag the size bars at the corners or edges of the window. 
 
 
Minimize command (application Control menu) 
 
Use this command to reduce the StarVIEW window to an icon. 
 
Shortcut 

Mouse: Click the minimize icon  on the title bar. 
Keys: ALT+F9 

 
Maximize command (System menu) 
 
Use this command to enlarge the active window to fill the available screen space. 
 
Shortcut 

Mouse: Click the maximize icon  on the title bar; or double-click the title bar. 
Keys: CTRL+F10 enlarges a document window. 

 



Close command (Control menus) 
 
Use this command to close the active window or dialog box. 
 
Double-clicking a Control-menu box is the same as choosing the Close command. 

 
 
   Clicking on the Close icon in the upper right corner of the window is the same as choosing 
the Close command. 
 
Note:  If you have multiple windows open for a single document, the Close command on the 
document Control menu closes only one window at a time.  You can close all windows at once 
with the Close command on the File menu. 
 
Shortcuts 

Keys:  CTRL+F4 closes a document window 
 ALT+F4 closes the StarVIEW window or dialog box 

  
 
Next Window command (document Control menu) 
 
Use this command to switch to the next open document window.  StarVIEW determines what 
window is next according to the order in which you opened the windows. 
 
Shortcut 

Keys: CTRL+F6 
 
Title Bar 
 

 
The title bar is located along the top of a window.  It contains the name of the application and 
current document. 
 
To move the window, drag the title bar.  Note: You can also move dialog boxes by dragging their 
title bars. 
 
A title bar may contain the following elements: 

 Application Control-menu  
 Document Control-menu  
 Maximize  
 Minimize  
 Name of the application 
 Name of the document 
 Restore  

 



Toolbar 
 

 
 
The toolbar is displayed across the top of the application window, below the menu bar.  The 
toolbar provides quick mouse access to many tools used in StarVIEW, 
 
To hide or display the Toolbar, select the View..Toolbar menu command (ALT, V, T). 
 
Click: To: 

 Change the test type (Test..Select Test Type) 

 Create a new test (Test..New Test) 

 Open an existing test (Test..Open Test) 

 Edit the current test (Test..Edit Test) 

 Open a stored data file (File..Open Data) 

 Save the current data to a file (File..Save Data) 

 Create a new graph (File..New Graph) 

 Autoscale the selected graph (Graph..Full Autoscale) 

 Edit the selected graph's settings (Graph..Edit Graph Settings) 

 Copy the selected graph to the windows clipboard (File..Copy Graph) 

 Print the selected graph (File..Print) 

 Stop the current test (Test..Stop Test) 

 Show the opening screen of the help file (Help..Help) 

 Context sensitive help (Help..What's This?) 
 



Status Bar 

 
 
The status bar is displayed at the bottom of the StarVIEW window.  To display or hide the status 
bar, select the View..Status Bar menu command. 
 
The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.  This area similarly shows messages that describe the actions of toolbar 
buttons and the meaning of numbers as you move the mouse over the buttons and numbers, 
respectively.  When the mouse is not over a toolbar or menu, this area displays the current stop 
code. 
 
The three other areas of the status bar indicate, from left to right, the current test type (e.g. Field 
Data Replicator), the name of the currently loaded test (e.g. Default), and the serial number of 
this controller machine (e.g. 0x0001). 
 
Scroll bars 
 
These are displayed at the right and bottom edges of the document window.  The scroll boxes 
inside the scroll bars indicate your vertical and horizontal location in the document.  You can use 
the mouse to scroll to other parts of the document. 
 



Chamber CRT View 
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window menu, 36 
x-axis, 33 
y-axis, 33 
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Software Update Policy

Vibration Research offers 1 year of StarVIEW software updates with the purchase of your new 
Envirotronics HALT/HASS system.  Each customer is entitled to any new major version which comes 
out inside the support year.  For example, if the current StarVIEW version is 2.0.7 and version 3.0.1 
is released within a year of your chamber delivery you would have access to the new version. After 1 
year, updating to the next major software release requires a support agreement.

Each customer is entitled to download any update available within a year.  You can update your 
software via a customer-specifi c website login.  After a year, the login expires unless you purchase a 
support agreement from Vibration Research.  To download current software (of whatever version you 
are entitled to), you may contact Vibration Research and request a password for the website.  

Vibration Research Corporation
2385 Wilshere Drive, Ste. A
Jenison MI 49428 USA
Offi ce: (616) 669-3028
Fax: (616) 669-5337
query@vibration research.com
www.vibrationresearch.com
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